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ÔN TẬP THI HỌC KỲ I LỚP 12 – NĂM HỌC 2013 – 2014

Giới thệu sơ qua Access 2002, 2003.

VẤN ĐỀ 1: Hãy nêu các khả năng của access
Cung cấp các công cụ tạo lập, lưu trữ, cập nhật và khai thác dữ liệu:

- Tạo lập các CSDL và lưu trữ chúng trên các thiết bị nhớ. Một CSDL được tạo lập bằng Access gồm các bảng dữ liệu và mối liện kết giữa các bảng đó

- Tạo biểu mẫu để cập nhật dữ liệu, tạo báo cáo thống kê, tổng kết hay những mẩu hỏi để khai thác trong CSDL, giải quyết các bài toán quản lí.

VẤN ĐỀ 2: Liệt kê các đối t​ượng chính trong Access và chức năng chính của chúng. 

Bảng (Table) : Là đối tượng cơ sở, được dùng để lưu dữ liệu.

Biểu Mẫu (Form): Là đối tượng giúp cho việc nhập và hiển thị thông tin một cách thuận tiện.

Mẫu hỏi (Query): là đối tượng cho phép kết xuất thông tin từ một hay nhiều bảng.

Báo cáo (Report): Là đối tượng được thiết kế để định dạng, tính toán, tổng hợp dữ liệu được chọn và in ra. 

VẤN ĐỀ 3: Hãy nêu thao tác khởi động access?

Có 2 cách khởi động access

· C1: Từ bảng chọn start -> all programs -> microsoft access
· C2: Nháy đúp vào biểu tượng access trên màn hình nền

 VẤN ĐỀ 4: Các thao tác để tạo một CSDL mới trong Access:

Để tạo một CSDL mới, sau khi khởi động Access cần:

1. Chọn File -> New;

2. Chọn Blank Database để tạo CSDL trống;

3. Trong hộp thoại File New Database chọn vị trí lưu tệp và đặt tên cho tệp CSDL mới.

VẤN ĐỀ 5: Hãy nêu thao tác kết thúc phiên làm việc với access
· c1: chọn file -> exit

· c2: nháy nút X ở góc trên bên trái màn hình làm việc với access

VẤN ĐỀ 6: . Hãy cho biết CSDL và Hệ Quản trị CSDL là gì?

CSDL là:

Một tập hợp các dữ liệu có liên quan với nhau chứa thông tin về một tổ chức nào đó (như một trường học, một nhà máy,...)

Được lưu trên các thiết bị nhớ;

Đáp ứng thông tin của nhiều người dùng với nhiều mục đích khác nhau.

Hệ QTCSDL là phần mềm:

Cho phép người dùng giao tiếp với CSDL

Cung cấp môi trường thuận lợi và hiệu quả để tạo lập, lưu trữ và tìm kiếm thông tin trong CSDL

VẤN ĐỀ 7: Trong Acces, dữ liệu được thể hiện dưới dạng gì? Mô tả các tính chất của trường

Mô ta dưới dạng bảng.

Các tính chất:

Field size: Cho phép đặt kích thước 

Format: Qui định hiển thị và in dữ liệu.

Short date: Nhập ngày tháng tương ứng.

Caption: Cho phép thay tên trường bằng các phụ đề.

Default Value: Giá trị ngầm định  

VẤN ĐỀ 8: Khai Thác hs gồm những thao tác nào?

 

Các thao tác khai thác hồ sơ:

- Sắp xếp hồ sơ theo 1 tiêu chí nào đó phù hợp với yêu cầu của tổ chức

- Tìm kiếm là việc tra cứu các thông tin có sẳn trong hồ sơ thoả mãn một số điều kiện nào đó.

- Thống kê là cách khai thác hồ sơ dựa trên tính toán để đưa ra các thông tin đặc trưng không có sẳn trong hồ sơ

- Lập báo cáo là việc sử dụng các kết quả tìm kiếm , thống kê, sắp xếp.

 VẤN ĐỀ 9: Cập nhật dữ liệu gồm những công việc nào ? cho ví dụ minh họa?

 Sửa chữa hồ sơ là việc thay đổi một vài thông tin trong hồ sơ 

- Bổ sung hồ sơ cho cá thể mới tham gia tổ chức

- Xoá hồ sơ của cá thể mà tổ chức không cần quản lí nữa.

VẤN ĐỀ 10: Có mấy cách lọc Dữ liệu? Nêu các bước lọc theo  mẫu[image: image1.png]


.  

Có 2 cách lọc.  Lọc theo ô dữ liệu đang chọn [image: image2.png]


  và 

 lọc theo mẫu[image: image3.png]



lọc theo  filter By from: nháy nút [image: image4.png]


 (lọc theo mẫu -  filter By from)

 rồi nhập điều kiện lọc.

 sau đó nháy nút lọc. [image: image5.png]


 để hiển thị kết quả.

Bấm nut [image: image6.png]


 một lần nữa để về trang bảng.
VẤN ĐỀ 11: Có mấy chế độ làm việc với bảng trong Access? Hãy nêu rõ nội dung của từng chế độ.

Có 2 chế độ làm việc  là thiết kế và chế độ bảng.
- Thiết kế: tạo ra cấu trúc bảng

-Chế độ bảng để nhập, sửa , xóa dữ liệu  

VẤN ĐỀ 12: Hãy chỉ ra các thao tác sắp xếp các bản ghi theo thứ tự tăng dần.(sgk/44)

VẤN ĐỀ 13: hãy nêu các tạo 1 biểu BIỂU MẪU? 

ĐỀ CƯƠNG ÔN TẬP HỌC KÌ I

MÔN: TIN HỌC  - KHỐI LỚP 12
CÂU HỎI TRẮC NGHIỆM:
Câu 1: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa bản ghi hiện tại, thao tác thực hiện lệnh nào sau đây là đúng

A. Edit/Delete Rows
B. Delete
C. Insert/New Record
D. Insert/Colum

Câu 2: Người nào đã tạo ra các phần mềm ứng dụng đáp ứng nhu cầu khai thác thông tin từ CSDL

A. Cả ba người
B. Người QTCSDL

C. Người dùng cuối
D. Người  lập trình ứng dụng

Câu 3: Trong Acess để tạo CSDL mới, thao tác thực hiện lệnh nào sau đây là đúng:

A. Create table by using wizard
B. Create Table in Design View

C. File/open/<tên tệp>
D. File/new/Blank Database

Câu 4: Khi chọn dữ liệu cho các trường chỉ chứa một trong hai giá trị như gioitinh, trường  đơn đặt hàng đã hoặc chưa giải quyết...nên chọn kiểu dữ liệu để sau này nhập dữ liệu cho nhanh.

A. Text
B. Number
C. Auto Number
D. Yes/No

Câu 5: Khi chọn kiểu dữ liệu cho trường số điện thoại nên chọn loại nào

A. Date/Time
B. Text
C. Autonumber
D. Number

Câu 6: Trong của sổ CSDL đang làm việc, để tạo một bảng mới trong chế độ thiết kế, thao tác thực hiện lệnh nào sau đây là đúng

A. File/New/Blank Database
B. Nhấp đúp <tên bảng>

C. Create Table entering data
D. Create Table in Design View

Câu 7: Các chức năng chính của Access

A. Lập bảng
B. Lưu trữ dữ liệu

C. Tính toán và khai thác dữ liệu
D. Ba câu  đều đúng

Câu 8: Trong Access để mở một CSDL đã có thao tác thực hiện lệnh nào sau đây là đúng

A. Create Table in Design View
B. File/open/<tên tệp>

C. File/new/Blank Database
D. Create table by using wizard

Câu 9: Bảng đã được hiển thị ở chế độ thiết kế muốn thêm một trường vào bên trên trường hiện tại, thao tác thực hiện lệnh nào sau đây là đúng

A. Insert/Rows
B. Create Table by Using Wizard

C. File/New/Blank Database
D. File/Save/<Tên tệp>

Câu 10: Để lọc ra danh sách học sinh “Nam” trong lớp, trên trường “Giới Tính” ta Click vào một ô có giá trị là “Nam” rồi:

A. Click vào nút [image: image7.png]



  B. Click vào nút [image: image8.png]


    C. Click vào nút [image: image9.png]



D. Tất cả đều đúng

Câu 11: Phần đuôi của tên tập tin trong Access là

A. MDB
B. ADB
C. DOC
D. XLS
Câu 12: Để mở một bảng ở chế độ thiết kế, ta chọn bảng đó rồi:

A. Click vào nút [image: image10.png]47 Design




B. Bấm Enter

C. Click vào nút [image: image11.png]INew




D. Click vào nút [image: image12.png]. ] Open




Câu 13: Trong CSDL đang làm việc, để mở một bảng đã có, thao tác thực hiện lệnh nào sau đây là đúng:

A. Create Table entering data
B. File/New/Blank Database

C. Nhấp đúp vào <tên bảng>
D. Create Table in Design View

Câu 14: Tập tin trong Access đươc gọi là

A. Tập tin cơ sở dữ liệu
B. Tập tin dữ liệu

C. Tập tin truy cập dữ liệu
D. Bảng

Câu 15: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc những bản ghi theo ô dữ liệu đang chọn, thao tác thực hiện lệnh nào sau đây là đúng

A. Record/Fillter/Fillter By Form
B. Insert/Colum

C. Record/Sort/Sort Ascending
D. Record/Fillter By Selection

Câu 16: Tên của tập tin trong Access bắt buộc  phải  đặt trước hay sau khi tạo CSDL

A. Đặt tên tệp sau khi đã tạo CSDL

B. Access tự đặt tên

C. Không có quy định này


D. Bắt buộc đặt tên tệp trước rồi mới tạo CSDL sau

Câu 17: Khi chọn kiểu dữ liệu cho trường thành tiền (bắt buộc kèm theo đơn vị tiền tệ) , nên  chọn loại nào

A. Date/time
B. Text
C. Currency
D. Number

Câu 18: Để lưu cấu trúc bảng đã thiết kế, thao tác thực hiện lệnh nào sau đây là đúng

A. Create Table by Using Wizard
B. File/New/Blank Database

C. File/Save/<Tên tệp>
D. File/Open/<tên tệp>

Câu 19: Access là gì?

A. Là phần cứng
B. Là phần mềm công cụ
C. Là hệ QTCSDL do hãng Microsoft sản xuất
D. Là phần mềm ứng dụng

Câu 20: Chọn kiểu dữ liệu nào cho truờng điểm Toán, Lý, Tin,...

A. Number
B. Currency
C. AutoNumber
D. Memo

Câu 21: Bảng đã được hiển thị ở chế độ trang dữ liệu, với một trường đã chọn, Muốn sắp xếp các bản ghi theo thứ tự tăng,  thao tác thự hiện lệnh nào sau đây là đúng

A. Record/Sort/Sort Descending
B. Insert/New Record

C. Insert/Colum
D. Record/Sort/Sort Ascending

Câu 22: Khi tạo bảng, trường “DiaChi” có kiểu dữ liệu là Text, trong mục Field size ta nhập vào số 300. Sau đó ta lưu cấu trúc bảng lại.

A. Access báo lỗi
B. Trường DiaChi có tối đa 255 kí tự

C. Trường DiaChi có tối đa 300 kí tự
D. Trường DiaChi có tối đa 256 kí tự

Câu 23: Chọn phát biểu đúng khi nói về bảng và khóa chính trong access

A. Bảng không cần có khóa chính
B. Bảng có thể có khóa chính hoặc không

C. Một bảng phải có một khóa chính
D. Một bảng phải có ít nhất một khóa chính

Câu 24: Để lọc danh sách học sinh của 2 tổ 1 và 2 của lớp 12A1, ta chọn lọc theo mẫu, trong trường “Tổ” ta gõ vào:

A. 1 or 2
B. Không làm được
C. 1 and 2
D. 1 2

Câu 25: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa trường đã chọn, thao tác thực hiện lệnh nào sau đây là đúng

A. Không thực hiện được
B. Edit/Delete Field

C. Edit/Delete Rows
D. Insert/Rows

Câu 26: Giả sử trường “DiaChi” có Field size là 50. Ban đầu địa chỉ của học sinh A là “Le Hong Phong”, giờ ta sửa lại thành “70 Le Hong Phong” thì kích thước CSDL có thay đổi như thế nào ?

A. Giảm xuống
B. Không đổi
C. Tăng lên

Câu 27: MDB viết tắt bởi

A. Manegement DataBase
B. Microsoft Access DataBase

C. .Microsoft DataBase
D. Không có câu nào đúng

Câu 28: Thành phần chính của hệ QTCSDL

A. Bộ quản lý tập tin và bộ xử lí truy vấn
B. Bộ truy xuất dữ liệu và bộ quản lý tập tin

C. Bộ xử lý truy vấn và bộ quản lí dữ liệu
D. Bộ quản lý tập tin và bộ truy xuất dữ liệu

Câu 29: Tên cột (tên trường) được viết bằng chữ hoa hay thường

A. Bắt buộc phải viết hoa
B. Không phân biệt chữ hoa hay thường

C. Bắt buộc phải viết thường
D. Tùy theo trường hợp

Câu 30: Người nào có vai trò quan trọng trong vấn đề phân quyền hạn truy cập sử dụng CSDL trên mạng máy tính.

A. Người lập trình
B. Người dùng cuối

C. Cả ba người
D. Nguời quản trị CSDL

Câu 31: Khi tạo một biểu mẫu mới, ta chọn thẻ Form, sau đó:

A. [menu] File → New

B. Click vào nút [image: image13.png]





C. Click vào nút [image: image14.png]




D. Cả A, B, C đều đúng

Câu 32: Trong chế độ biểu mẫu, ta có thể chuyển sang chế độ thiết kế bằng cách dùng menu:

A. Format→Design View

B. View→Design View 

C. Tools→Design View

D. Edit →Design View 
Câu 33: Thao tác nào sau đây có thể thực hiện được trong chế độ biểu mẫu?

A. Thêm một bản ghi mới

B. Định dạng font chữ cho các trường dữ liệu

C. Tạo thêm các nút lệnh

D. Thay đổi vị trí các trường dữ liệu 

Câu 34: Để làm việc trong chế độ biểu mẫu, ta không thực hiện thao tác nào sau đây?

A. Click đúp chuột vào tên biểu mẫu
B. Chọn biểu mẫu rồi Click vào nút [image: image15.png]



C. Trong chế độ thiết kế, Click vào nút [image: image16.png]



D. Trong chế độ thiết kế,  Click vào nút [image: image17.png]&< Design




Câu 35: Trong chế độ Thiết kế của biểu mẫu, ta có thể:

A. Sửa đổi cấu trúc của biểu mẫu
B. Sửa đổi dữ liệu


C. Nhập và sửa dữ liệu

D. Xem, sửa, xóa và nhập dữ liệu 

Câu 36: Trong Access, để tạo liên kết giữa 2 bảng thì hai bảng đó phải có hai trường thỏa mãn điều kiện:


A. Có tên giống nhau

B. Có kiểu dữ liệu giống nhau


C. Là khóa chính

D. Cả A, B, C

Câu 37: Trong Access, khi tạo liên kết giữa các bảng, hãy chọn phát biểu đúng:


A. Phải có ít nhất một trường là khóa chính
B. Cả hai trường phải là khóa chính


C. Hai trường không nhất thiết phải là khóa chính
D. Một trường là khóa chính, một trường không

Câu 38: Để xóa liên kết, trước tiên ta chọn liên kết cần xóa. Thao tác nào sau đây sai?


A. Bấm Phím Delete ( Yes
B. Click phải chuột, chọn Delete ( Yes


C. [menu] Edit ( Delele ( Yes
D. [menu] Tools ( RelationShip ( Delete ( Yes

Câu 39: Khi liên kết bị sai, ta có thể sửa lại bằng cách chọn liên kết cần sửa, sau đó:


A. Bấm đúp chuột vào liên kết ( chọn lại trường cần liên kết


B. [menu] Edit ( RelationShip ( Change Field


C. [menu] Tools ( RelationShip ( Change Field
D. Cả A và D đều đúng.

Câu 40: Điều kiện cần để tạo được liên kết là:


A. Phải có ít nhất hai bảng
B. Phải có ít nhất một bảng và một mẫu hỏi


C. Phải có ít nhất một bảng mà một biểu mẫu
D. Tổng số bảng và mẫu hỏi ít nhất là 2

Câu 41: Trong Access, nút lệnh này [image: image18.bmp] có ý nghĩa gì ?

A.Xác định khoá chính


B.Khởi động Access
C.Cài mật khẩu cho tệp cơ sở dữ liệu

D.Mở tệp cơ sở dữ liệu

Câu 42: Trong Access, muốn tạo biểu mẫu theo cách dùng thuật sĩ, ta chọn


A.Create form by using Wizard
B.Create form in using Wizard


C.Create form for using Wizard
D.Create form with using Wizard

Câu 43: Trong Access, khi nhập dữ liệu cho bảng, giá trị của field GIOI_TINH là True. Khi đó field GIOI_TINH được xác định kiểu dữ liệu gì ?


A.Yes/No
B.Boolean
C.True/False
D.Date/Time

Câu 44:Trong khi làm việc với cấu trúc bảng, muốn chèn thêm một trường mới, ta thực hiện :


A.Insert – Rows     B.Tools – Insert Rows       C.File – Insert Rows          D.Edit – Insert Rows

Câu 45: Trong Access, kiểu dữ liệu số được khai báo bằng từ ?


A.Number
B.Text
C.Memo
D.Curency

Câu 46: Điều kiện để tạo mối liên kết giữa hai bảng là :


A.Trường liên kết của hai bảng phải cùng kiểu dữ liệu   B.Trường liên kết của hai bảng phải là chữ hoa

         C.Trường liên kết của hai bảng phải là kiểu dữ liệu số    D.Trường liên kết của hai bảng phải khác nhau về kiểu dữ liệu

Câu 47:Hãy sắp xếp các bước sau để được một thao tác đúng ?
(1) Chọn nút Create                 (3) Nhập tên cơ sở dữ liệu    (2) Chọn File – New          (4) Chọn Blank Database

     A.(2) ( (4) ( (3) ( (1)     B. (1) ( (2) ( (3) ( (4)   C.(1) ( (2) ( (4) ( (3)   D. (2) ( (3) ( (4) ( (1)

Câu 48:Trong Access, để tạo mối liên kết giữa các bảng, ta thực hiện : ............ ( Relationships

A.Tools
B.Format
C.Insert
D.Edit
Câu 49:Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại dòng :


A.Field Size 
B.Field Name
C.Data Type
D.Description

Câu 52:Trong Access để mở một Cơ sở dữ liệu đã có, thao tác thực hiện lệnh nào sau đây là đúng:

A.File/Open/<Tên tệp>

B.Create Table in Design View 
C.File/Open/Blank Database

D.Create Table by using wizrd
Câu 53:Trong Access, muốn sắp xếp các bản ghi theo thứ tự, ta thực hiện ............( Sort


A.Record
B.Tools
C.Insert
D.File

Câu 54:Trong Access, muốn nhập dữ liệu vào cho một bảng, ta thực hiện :


A.Nháy đúp trái chuột lên tên bảng cần nhập
B.Nháy phải chuột lên tên bảng cần nhập


C.Nháy đúp phải chuột lên tên bảng cần nhập
D.Nháy trái chuột lên tên bảng cần nhập

Câu 55:Trong Access, ta có thể sử dụng biểu mẫu để :


A.Nhập dữ liệu      B.Sửa cấu trúc bảng       C.Lập báo cáo    D.Tính toán cho các trường tính toán

Câu 56:Trong Access, muốn tạo một cơ sở dữ liệu mới, ta thực hiện


A.File – New
B.Insert – New
C.View – New
D.Tools – New

Câu 57:Trong Access, muốn làm việc với đối tượng bảng, tại cửa sổ cơ sở dữ liệu ta chọn nhãn :


A.Tables
B.Forms
C.Queries
D.Reports

Câu 58:Trong Access, muốn làm việc với đối tượng biểu mẫu, tại cửa sổ cơ sở dữ liệu ta chọn nhãn :


A.Forms
B.Tables
C.Reports
D.Queries

Câu 59:Khi nào thì có thể nhập dữ liệu vào bảng?

A.Sau khi bảng đã được tạo trong CSDL; 
B.Ngay sau khi CSDL được tạo ra; 

C.Bất cứ khi nào cần cập nhật dữ liệu;
D.Bất cứ khi nào có dữ liệu.

Câu 60 :Số hiệu bản ghi để xác định các bản ghi và được gán cho các bản ghi bởi:

A.Hệ quản trị CSDL;
     B.Người thiết kế CSDL;
C.Người sử dụng CSDL;         D.Cả ba phương án;

Câu 61 Trong chế độ thiết kế, một trường thay đổi khi:

A.Một trong những tính chất của trường thay đổi;
B. Tất cả các phương án
C.Tên trường thay đổi;



D.Kiểu dữ liệu của trường thay đổi;

Câu 62:Một bảng có thể có tối đa bao nhiêu trường

A.255;

B.552;


C.525;

D.Chỉ bị giới hạn bởi bộ nhớ;

Câu 63 :Để chỉ định khóa chính cho một bảng, sau khi chọn trường, ta thực hiện:

A.Chọn Edit ( Primary key;

B.Chọn Table ( Edit key; 

C.Chọn View ( Primary key;
D.Chọn Tools ( Primary key;

Câu 64: Phần đuôi của tên tập tin trong Access là

A.MDB
B.DOC
C.TEXT
D.XLS

Câu 65: Khi thiết kế xong bảng, nếu không chỉ định khóa chính thì:

A.Access đưa lựa chọn là tự động tạo trường khóa chính cho bảng;

B.Access không cho phép lưu bảng;

C.Access không cho phép nhập dữ liệu;

D.Dữ liệu của bảng sẽ có hai hàng giống hệt nhau;

Câu 66: Trong Access, một bản ghi được tạo thành từ dãy:

A.Trường;

B.Cơ sở dữ liệu;

C.Tệp;


D.Bản ghi khác;

Câu 67: Muốn xóa liên kết giữa các bảng, trong cửa sổ Relationships ta thực hiện:

A.Chọn đường liên kết giữa hai bảng đó và nhấn Delete;
B.Chọn hai bảng và nhấn Delete;

C.Chọn tất cả các bảng và nhấn Delete;


D.Không thể xóa được;

Câu 68: Truy vấn có nghĩa là:

A.Tìm kiếm và hiển thị dữ liệu;
B.In dữ liệu;  C.Xóa các dữ liệu không cần dùng đến;    D.Cập nhật dữ liệu;

Câu 69 Đối tượng nào không dùng để cập nhật dữ liệu:

A.Báo cáo;

B.Bảng;
C.Biểu mẫu;


D.Mẫu hỏi;

Câu 70: Khi cần in dữ liệu theo một mẫu cho trước, cần sử dụng đối tượng:

A.Báo cáo;
B.Bảng;
C.Mẫu hỏi;

D.Biểu mẫu;

Câu 71: Cấu trúc bản ghi được xác định bởi:

A.Các trường và thuộc tính của nó;

B.Các thuộc tính của đối tượng cần quản lý;

C.Các bản ghi và dữ liệu;


D.Thuộc tính của bảng;

Câu 72: Nếu thêm nhầm một bảng làm dữ liệu nguồn trong khi tạo mẫu hỏi, để bỏ bảng đó khỏi cửa sổ thiết kế ta thực hiện :

A.Query ( Remove Table
B.Edit ( Delete Tabl     C.Query ( Delete Table       D.Edit ( Remove Table

Câu 73: Khi tạo cấu trúc bảng, tên trường được nhập vào cột :

A.Field Name 

B.Description

C.Date Type 

D.Field Properties

Câu 74: Trong cửa sổ CSDL đang làm việc, muốn dùng thuật sĩ để tạo biểu mẫu, thao tác nào sau đây là đúng 
A.Form/ Create Form by using Wizard/ <Chọn trường>/ Next. 
B.Record/ Filter/ Filter by Form.


C.Record/ Filter/ Filter by Selection.


D.Insert/ Form.

Câu 75: Trong cửa sổ CSDL đang làm việc, để mở một mẫu hỏi đã có, ta thực hiện :

A.Queries/ Nháy đúp vào tên mẫu hỏi. 
B.Queries/ nháy nút Design.
C.Queries/ Create Query by using Wizard
D.Queries/ Create Query in Design New.

Câu 76: Trong các chức năng sau, chức năng nào không phải là chức năng của hệ quản trị CSDL ?

A.Cung cấp cách quản lí tệp 




B.Cung cấp cách tạo lập CSDL

C.Cung cấp cách cập nhật, tìm kiếm và kết xuất thông tin
D.Cung cấp công cụ kiểm soát việc truy cập vào CSDL

Câu 77 Để sửa cấu trúc bảng, sau khi chọn tên bảng ta nhấn nút:

A.[image: image19.png]




B.[image: image20.png]




C.[image: image21.png]




D.Cả 3 nút đều sai

Câu 78 :Các bước để tạo liên kết với bảng là:


1. Tạo trang bảng chọn Tool\Relationships…


2. Tạo liên kết đôi một giữa các bảng


3. Đóng hộp thoại Realationships/ Yes để lưu lại


4. Chọn các bảng sẽ liên kết

A.1, 4, 2, 3 

B.2, 3, 4, 1

C.1, 2, 3, 4 

D.4, 2, 3, 1 

Câu 79: Để lưu cấu trúc bảng mới được thiết kết, ta thực hiện thao tác:

A.File/ Save/ <Tên tệp>;


B.File/ Save/Blank Database;

B.Edit/ Save As/ <Tên tệp>;


C.Edit/ Save/ <Tên tệp>;

Câu 80: Các trường mà giá trị của chúng được xác định duy nhất mỗi hàng của bảng được gọi là:

A.Khóa chính 


B.Bản ghi chính
C.Kiểu dữ liệu

D.Trường chính

Câu 82:  Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc các bản ghi theo dữ liệu ô được chọn, ta thực hiện thao tác :

A.Nháy nút [image: image22.bmp]
B.Nháy nút [image: image23.bmp]
C.Nháy nút [image: image24.bmp]
D.Nháy nút [image: image25.png]



Câu 83: Để thay đổi cấu trúc của biểu mẫu, sau khi chọn tên biểu mẫu ta thực hiện:

A.Nhấn nút [image: image26.png]18, Design




B.Chọn Create Form In Design View

C.Nhấn nút [image: image27.png]




D.Chọn Create Form By Using Wizard

Câu 84: Để tạo cấu trúc một bảng trong CSDL, ta thực hiện lần lượt các thao tác:

1. Mở cửa sổ CSDL, chọn nhãn Table

2. Trong cửa sổ Table: gõ tên trường, chọn kiểu dữ liệu, mô tả, định tính chất trường

3. Tạo cấu trúc theo chế độ thiết kế

4. Lưu cấu trúc bảng

5. Chỉ định khóa chính

A.1, 3, 2, 5, 4  

B.3, 4, 2, 1, 5

C.2, 3, 1, 5, 4 

D.1, 2, 3, 4, 5

Câu 85: Để tạo liên kết giữa các bảng, ta chọn: 

A.Tool/ Relationships hoặc nháy nút [image: image28.bmp] 

B.Tool/ Relationships

C.Edit/ Insert/ Relationships



D.Tất cả đều đúng

Câu 86: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn tìm kiếm các bản ghi theo một điều kiện nào đó, ta thực hiện thao tác:

A.Edit/ Find/ <Điều kiện>


B.Record/ Filter/ Filter By Selection

C.Record/ Sort/ Sort Decending

D.Record/ Filter/ Filter By Form

Câu 88: Một đối tượng trong Access có thể được tạo ra bằng cách:

A.Thiết kế, dùng thuật sĩ hoặc kết hợp cả 2

B.Người dùng tự thiết kế

C.Kết hợp thiết kế và thuật sĩ



D.Dùng các mẫu dựng sẵn

Câu 89 :Cơ sở dữ liệu là:

A.tập hợp các thông tin liên quan đến một tổ chức nào đó 

B.phần mềm cung cấp công cụ kiểm soát và điều khiển truy cập dữ liệu

C.phần mềm cung cấp công cụ tạo lập CSDL

D.phần mềm cung cấp công cụ cập nhật, lưu trữ và tìm kiếm dữ liệu
Câu 90: Để sắp xếp các bản ghi theo thứ tự giảm dần của tuổi, ta chọn cột ngày sinh, rồi: 

A. kích chuột vào biểu tượng 
[image: image29.png]


 
B. Nhấn tổ hợp phím Ctrl + S 


C. kích chuột vào biểu tượng 
[image: image30.png]
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